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1.  Introduction 
[LDK Remote Diagnostic Tool] is a MS-Windows application program that may be 
used with PC Admin program. This program is for diagnosing problems of LDK system 
and also maintaining the system from remote site. This program can send and receive 
the results of diagnostic commands of LDK system such as GSXD test, Board 
configuration, S/W reset count, Station status, CO status, Station recovery, CO recovery, 
Version display, Help message, and Log out. 

1.1. Hardware/Software Requirements 
The system requirements for using this program are as follows; 

1.  LDK  
 LDK-300 MPB Software Ver 1.0Fc or later 
 Serial Port that is installed on MPB as a basic option. 
 LAN Port should be installed on MPB for LAN connection. 
 Unique IP Address should be assigned for LAN connection. 
 MODU that is installed on MPB. 

2.  PC 
 Pentium Celeron 233MHz CPU or Higher CPU 
 256 color Super VGA (800 * 600) or higher 
 One or more Serial Port 
 NIC(Network Interface Card) for LAN Connection. 
 ISDN S-Card for ISDN Connection.(Optio 
 2 button Mouse 
 At least 32MB RAM  
 MS-Windows 95/98/2000/me/XP/NT 
 Enough hard drive space for installation 

 
3.  Cable 

 RS-232C Type Cable for connecting PC and LDK system: Two connectors are 
needed for this connection. One connector should be a 9-pin female connector 
that is to be connected to LDK, and the other one should fit the serial port of 
the PC. There are three required lines that should be connected for the 
communication between PC and LDK system: Ground-Ground, Transmit-
Transmit, and Receive-Receive. 

 If external modem is used for PC, serial cable is need for the connection 
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between PC and modem. About the connection between PC and modem, user 
must refer to the user’s manual of the modem and follow the description. 

 If NIC is used for LAN connection, UTP cable will be needed with RJ-45 Jack 
between PC and LDK system. 

1.2. Hardware Configuration 
In order to use serial connection between PC and LDK system, PC should be 

connected to the basic serial port of LDK system. 
In order to use modem connection between PC and LDK system, MODU should be 

installed in LDK system and a modem should be installed in PC. 
In order to use LAN connection between PC and LDK system, PC and LDK system 

should be connection local network. 
In order to use ISDN connection between PC and LDK system, PC should be 

connection to ISDN line. 

1.3. Installing Software 
Once the hardware is installed, you are ready to install the software. 

Microsoft windows must be installed on your computer before you install [LDK 
Remote Diagnostic Tool] program. For information on installing Windows, refer to 
appropriate user’s manual.  
 This remote diagnostic software is a part of PC Admin software package like remote 
upgrade. So, you should install the PC admin software package to use remote 
diagnostic software. 

 

1.4. Uninstalling Software 
To uninstall [LDK Remote Diagnostic Tool] program, follow the procedure 
below : 
1) Click Uninstall – PC Admin menu that is under PC Admin for LDK in Program 

menu of MS-Windows. Or, user can also select PC Admin in Add/Remove 
Program in Control Panel. 

2) <Confirm File Deletion> message box that asks if the user wants to remove PC 
Admin files shows up. Click Yes button to proceed. 

1.5. Important Notes for Users 
 [LDK Remote Diagnostic Tool] is installed with PC Admin program. 
 When you uninstall [LDK Remote Diagnostic Tool] program, PC Admin program 
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is also uninstalled. 
 In order to use modem connection with this program, TAPI and TAPI32 Dynamic-

Link Library and TAPISRV.EXE should be installed in MS-Windows. These files 
are installed in most of the PCs MS-Windows is installed. 

 When you uninstall [LDK Remote Diagnostic Tool], some files may not be 
deleted if the files were create after the installation of this program. Those files can 
be [PhoneNo.txt] file that is created after [Save] button is clicked on [Phone 
Number Dialog], or other saved files or backup files, and so on. 

 If [GSXD Test] command is executed on the system that does not use GSXD 
chipset, the result of [GSXD Test] shows a message that indicates this condition. 
In order to log-on to LDK system again after log-out from LDK system, click 
[Enter] button in [Input Box Bar]. 

 When this program is executed, some components of this program (i.e. buttons in 
[Command Bar]) may be hidden. In this case, enlarge or maximize the window, 
then you will see all the components of this program. 

 The title of a button in [Command Bar] may be aligned into two lines if the length 
of the title is long. 



IPLDK Remote Diagnostic                Issue 3.0 

 

4 

1.6 Full Screen Layout 
 

 

 

 
 

[Fig 1.1] Full Screen Layout 
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2. [File] Menu 
[File] menu includes [Open], [Save], [Save As], [Print], [Print Preview], [Print 
Setup], and [Recent Files] that are file related operations. 

 
 [Fig 2-1] [File] Menu 

 

2.1. [Open] Sub-menu  
Procedures: 
1.  Select [Open] sub-menu in [File] menu.  =>  [Open Dialog] shows up. 
2.  Or, user can use tool button  in [ToolBar] to execute the same command.  
3.  Select one of the saved files. (File extension is *.dat) 
4.  Click [OK] button. 
5.  The dialog is closed, and the contents of the file is displayed in [Data Display 

Area]. 
 

2.2. [Capture On] Sub-menu 
Procedures: 
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1. Select [Capture On] sub-menu in [File] menu. .  =>  [Save As Dialog] shows 
up. 

2. Enter different file name. 
3.  Click [OK] button. 

2.3. [Capture Off] Sub-menu 
Procedures: 
1. Select [Capture Off] sub-menu in [File] menu. 
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3.  [Connection] Menu 
LDK system and this program can be connected in four ways, Serial, Modem, Lan, 
ISDN. 

 
[Fig 2-2] [Connection] menu 

 

3.1. Serial Port Connection with LDK System 
For the serial port connection between PC and LDK system, there must be a physical 
connection with RS-232C standard serial cable. 
 ** Serial Port may not be established through Window2000. 

(Recommend to use Window98 to use serial port) 
Conditions: 

1.  The pins used in connection cable should be connected as follows; 
 [Transmit] : [Transmit] of LDK and [Transmit] of PC should be connected. 
 [Receive] : [Receive] of LDK and [Receive] of PC should be connected. 
 [Ground] : [Ground] of LDK and [Ground] of PC should be connected. 

2.  The length of connection cable depends on the communication environment of 
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the system. In normal condition, the cable length is limited to 15 meters. In better 
condition, 30-meter cable can be used. 

3.  In LDK-300 system, it is connected to the serial port in MPB. Select one of the 
transmission rates among 2400bps, 4800bps, 9600bps. 

3.1.1.  [Serial Port Configure] Sub-menu 
[Serial Port Configure] is for configuring serial port of PC that is to be connected to 
LDK system. 
Conditions: 

1.  When the serial port connection is established, user cannot select this menu. The 
menu item is disabled in that case. 

2.  Setting values are stored for the next session at which they are automatically 
restored and used. 

 

 
[Fig 2-3] Serial Port Configuration 

Procedures: 
1.  Select [Serial Port Configure] sub-menu in [Connection] menu. 
2.  [Serial Port Configuration Dialog] shows up. 
3.  Enter setting values. 

 [Port] : Select connection port to be connected to LDK. 
 [Baud Rate] : Select one of 2400bps, 4800bps, 9600bps. Selected [Baud Rate] 

must be same as that of LDK. 
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 [Parity] : Select [None]. 
 [Data Bits] : Select [8]. 
 [Stop Bits] : Select [1]. 
 [Flow] : All of [DTR/DSR], [RTS/CTS], [XON/XOFF] are not to be checked. 

4.  Click [OK] button. 

3.1.2.  [Serial Port Connect] Sub-menu 
[Serial Port Connect] connects the serial port of PC and LDK system with the setting 
values from [Serial Port Configure]. 
Conditions: 

1.  If the connection is failed, an error message shows up. It means that other 
program is using the serial port or the port does not exist. 

 

 
[Fig 2-4] Serial Port Connection Fail 

 
2.  If the connection is established successfully, a message box shows up notifying 

this. The success of connection means that the connection between this program 
and the serial port of the PC is succeeded. This does not mean the connection 
between this program and LDK system is succeeded. 

 

 
[Fig 2-5] Serial Port Connection Success Dialog 

 
3.  If the serial port is already connected, the sub-menu and the tool button for serial 

port connection cannot be selected. 
Procedures: 

1.  Select [Connection] menu. 
2.  Select [Serial Port Connect] in [Connection] menu. 
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3.  Or, user can use tool button  in [ToolBar] to execute the same command. 
 

3.1.3.  [Serial Port Disconnect] Sub-menu 
[Serial Port Disconnect] disconnects the serial port connection between PC and LDK. 
Conditions: 

1.  If the two serial ports are already disconnected, the menu and the toolbar for 
serial port disconnection cannot be selected. 

Procedures:  
1.  Select [Connection] menu. 
2.  Select [Serial Port Disconnect] sub-menu in [Connection] menu. 
3.  Or, user can use tool button  in [ToolBar] to execute the same command. 
 

3.2. Modem Connection with LDK System 
For the modem connection between PC and LDK system, internal or external modem is 
needed for PC. Before executing this program, a modem should be installed in PC. 
Modem installation does not merely mean the physical connection between PC and 
modem but it includes all the procedures needed such as installing device driver file for 
MS-Windows. 

3.2.1.  [Modem Configure] Sub-menu 
 [Modem Configure] is for configuring modem of PC that is to be connected to LDK 
system. 
Conditions: 

1. When the modem connection is established, user cannot select this menu. The 
menu item is disabled in that case. 

2. MODU should be installed on the MPB of LDK system. 
3. By clicking [Configure] button in [Modem Configuration Dialog], user can 

select or change various settings for modem configuration. The setting values are 
effective only during the execution time of this program and are not stored for 
next execution. Those values do not affect the modem settings of MS-Windows 
itself. In order to change modem configuration, it has to be done in [Control 
Panel] of MS-Windows. The changed settings from [Control Panel] are applied 
to all the application programs using modem. 
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[Fig 2-6] Modem Configuration 

 
 

Procedures: 
1. If needed, select or change modem settings by using [Control Panel]. 
2. Select [Modem Configure] sub-menu in [Connection] menu.  
3. [Modem Configuration Dialog] shows up. 
4. The dialog shows current settings. 

 [Select Active Device] : Select a modem that is to be used for modem 
connection with LDK system. The setting value is stored, and is restored and 
used when this program is executed next time. 

 [Configure] button : This is for setting detailed modem configurations. The 
setting values are effective only during the execution time of this program and 
are not stored for next execution. Those values do not affect the modem 
settings of MS-Windows itself. 

5. Click [OK] button. 

3.2.3.  [Modem Connect] Sub-menu 
[Modem Connect] establishes modem connection with the setting values from 
[Modem Configuration]. 
Conditions: 

1. If connection failure occurs, an error message is shown. The reason for the failure 
may be improper installation of modem, turning-off state of modem, busy state of 
destination, or various telecommunication problems that may occur during the 
session. 
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[Fig 2-7] Modem Connect Fail 
 

2. If unavailable phone number is entered or full phone number is not entered or 
destination does not answer, the connection is disconnected after a period of time 
that was set from [Modem Configure] as a time-out value. 

3. When making a modem connection, [Call Status Dialog] that shows the status of 
modem call shows up. This program shows call status messages sent from modem 
or modem device driver. Therefore, the messages in [Call Status Dialog] may 
differ from modem to modem. [Call Status Dialog] can be hidden from the screen 
by clicking [Hide] button on the right of [Call Status Dialog]. 

 

 
[Fig 2-9] Modem Connect State 

 
4. When the modem connection is established, user cannot select this menu. The 

menu item is disabled in that case. 
 

Procedures: 
1. Select [Modem Connect] sub-menu in [Connection] menu.  =>  [Phone 

Number Dialog] shows up. 
2. Or, user can use tool button  in [ToolBar] to execute the same command. 
3. Enter phone number and make a modem call to destination by using [Phone 

Number Dialog]. (Refer to the description below for detailed explanation about 
how to use [Phone Number Dialog].) 

4. If connection failure occurs, an error message is shown, and if the connection is 
established, a message box shows up to notify this. 

. 

3.2.3.1 [Phone Book] 
[Phone Book] is used for entering / storing phone numbers and making a modem call 
to destination. 
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[Fig 2-9] Modem Phone Book 

Procedures: 
 In order to open [Phone Book], click [Modem Connect] sub-menu. 
 In order to close [Phone Book], click [Quit] button. 
 When entering new phone number ; 

 

 
[Fig 2-10] Modem Phone Number Dialog 

 
1. Click [New] button to enter new phone number  =>  [Edit Phone Number 

Dialog] shows up. 
2. Enter [Name] and [Phone Number]. [Name] and [Phone Number] can be 

input up to 40 characters, respectively. Five characters of ‘{‘, ‘}’, ‘[‘, ‘]’, ‘;’ 
cannot be entered for [Name]. For [Phone Number], only [Dialable 
Characters] can be input. (Refer to the description below for detailed 
explanation about [Dialable Characters].) 
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3. Newly entered phone number is shown in [Phone Number Dialog] if [OK] 
button is clicked. Click [Cancel] button to cancel the input. 

4. If user wants to save the new phone numbers into [PhoneNo.txt] file for future 
use, click [Save] button in [Phone Number Dialog]. If user closes [Phone 
Number Dialog] without clicking [Save] button, the newly entered phone 
number will be lost. 

 When modifying existing phone number ; 
1. In [Phone Number List Box], select a phone number item to be modified by 

clicking the [Name] of the item. 
2. After a selection is made, click [Modify] button.  =>  [Edit Phone Number 

Dialog] shows up. 
3. Modify [Name] and/or [Phone Number]. [Name] and [Phone Number] can 

be input up to 40 characters, respectively. Five characters of ‘{‘, ‘}’, ‘[‘, ‘]’, ‘;’ 
cannot be entered for [Name]. For [Phone Number], only [Dialable 
Characters] can be input. (Refer to the description below for detailed 
explanation about [Dialable Characters].) 

4. Modified phone number is shown in [Phone Number Dialog] if [OK] button 
is clicked. Click [Cancel] button to cancel the input. 

5. If user wants to save the modified phone number into [PhoneNo.txt] file for 
future use, click [Save] button in [Phone Number Dialog]. If user closes 
[Phone Number Dialog] without clicking [Save] button, the modification will 
be lost. 

 When deleting existing phone number ; 
1. In [Phone Number List Box], select a phone number item to be deleted by 

clicking the [Name] of the item. 
2. After a selection is made, click [Delete] button.  =>  [Delete Confirmation 

Message Box] shows up. 
3. Deleted phone number is disappeared from [Phone Number Dialog] if [OK] 

button is clicked. Click [Cancel] button to cancel the deletion. 
4. If user wants to remove the deleted phone number from [PhoneNo.txt] file, 

click [Save] button in [Phone Number Dialog]. If user closes [Phone Number 
Dialog] without clicking [Save] button, the deletion will not be made in the file. 

 When storing the contents of [Phone Number List Box] into file ; 
1. Click [Save] button in [Phone Number Dialog]. 
2. A message box indicating success or failure of [Save] operation shows up. 
 The contents of [Phone Number List Box] are saved in [PhoneNo.txt] file that 
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is located in the directory this program is installed. User must not edit this file, 
and if user deletes this file by mistake, all the data in the file will be lost. 

 For the stable use of [Phone Number Dialog], it is recommended to keep less 
than 1000 phone numbers. However, this program does not check and limit the 
number of phone numbers. 

 
 When making a modem call by using [Phone Number List] ; 
1. In [Phone Number List Box], select a phone number item to be called by 

clicking the [Name] of the item. 
2. Click [Call] button in [Phone Number Dialog]  =>  [Call Information 

Message Box] shows up. 
3. If [OK] button is clicked, modem call is started. Click [Cancel] button to 

cancel the modem call. 
Or, 
1. Double-click on an item in [Phone Number List Box]  =>  [Call 

Information Message Box] shows up. 
2. If [OK] button is clicked, modem call is started. Click [Cancel] button to 

cancel the modem call. 
 When making a modem call with [Speed Call] button ; 

 

 
[Fig 2-11] Speed Call 

 
1. Click [Speed Call] button in [Phone Number Dialog]  =>  [Speed Call 

Dialog] shows up. 
2. Enter phone number in [Phone Number] field. In [Phone Number] field, only 

[Dialable Characters] can be input. (Refer to the description below for 
detailed explanation about [Dialable Characters].) 

3. Click [OK] button, then [Call Information Message Box] shows up. If [OK] 
button is clicked on [Call Information Message Box], modem call is started. 
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Click [Cancel] button to cancel the modem call. If [Cancel] button is clicked 
in [Speed Call Dialog], the modem call is canceled. 

 
3.2.3.2 [Dialable Characters] 

[Dialable Characters] are used to form a phone number that can be dialed. This 
program supports generally used [Dialable Characters]. Part of the [Dialable 
Characters] may not be working properly for some telephone network or modem. 

 0 – 9  A – D  *  # 
DTMF and/or pulse digits. 

 ! 
Hookflash (One-half second onhook, followed by one-half second offhook before 
continuing). 

 P  p 
Pulse dialing is to be used for the digits following this. 

 T  t 
Tone (DTMF) dialing is to be used for the digits following this. 

 , 
This indicates that dialing is to be paused. The duration of a pause is device 
specific. Multiple commas can be used to provide longer pauses. 

 W  w 
This indicates that dialing should proceed only after a dial tone has been detected. 

 $ 
This indicates that dialing the billing information is to wait for a "billing signal" 
(such as a credit card prompt tone). 

 

3.2.4.  [Modem Disconnect] Sub-menu 
[Modem Disconnect] disconnects modem connection. 
Conditions: 

1. When the modem connection is disconnected, user cannot select this menu. The 
menu item is disabled in that case. 

 
Procedures: 

1. Select [Connection] menu. 
2. Select [Modem Disconnect] sub-menu in [Connection] menu. 
3. Or, user can use tool button   in [ToolBar] to execute the same command. 
4. If disconnection failure occurs, an error message is shown, and if the connection 
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is disconnected, a message box shows up to notify this. 
 

3.2.5. Important Note for Users 
 The success of serial port connection means that the connection between this 

program and the serial port of the PC is succeeded. This does not mean the 
connection between this program and LDK system is succeeded. 

 Even though serial port or modem connection is disconnected by accident or some 
other reason, this program does not detect this. Instead, this program shows a 
message box if there is no answer after sending a command to LDK system. 

 If modem connection is not established after a period of time that was set from 
[Modem Configure] as a time-out value, this program give up making a modem 
connection and shows a message box to notify this. 

 

3.3 LAN Connection with LDK System 
For the LAN connection between PC and LDK system, there must be a physical 

connection with 10BaseT Cable to local network. And LDK system and PC should have 
valid IP address. 
 
Conditions: 

1. LDK system and PC should have valid IP address. 
2. If you want to connect directly, you have to use cross UTP cable. That means 

that the [Transmit] and [Receive] are cross. But you connect the LDK system 
and PC with HUB, you can use normal UTP cable that is used in your local 
network. 

3. If you want to connect from the different segment of LAN or from external 
site(via Internet), LDK system should have correct gateway address(default 
router). If it doesn’t have gateway address, remote connection using TCP/IP 
will be not available. 

4. If you want to connect the LDK system that is used in remote site, you may 
need some help from network administrator. Because many site uses the 
firewall/NAT/PAT in their router. So, to connect the system through the 
Internet, some help will be needed. 

5. In remote connection using Internet, connection speed / stability is depend on 
the environment of WAN traffic or routing 
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3.3.1.  [LAN Configure] Sub-menu 
[LAN Configure] is for configuring the destination IP address that is to be connected to 
LDK system. 
Conditions: 

1. When the LAN connection is established, user cannot select this menu. The 
menu item is disabled in that case. 

2. Setting values are stored for the next session at which they are automatically 
restored and used. But only one IP address will be saved. 

 

 
[Fig 3-1] LAN Configuration 

Procedures: 
1. Select [LAN Configure] sub-menu in [Connection] menu. 
2. [LAN Configuration Dialog] shows up. 
3. Enter the destination IP address. 
4. Click [OK] button. 

3.3.2.  [LAN Connect] Sub-menu 
[LAN Connect] connects the PC and LDK system with the setting IP address from 
[LAN Configure]. 
 
Conditions: 

1. If the connection is failed, an error message shows up. It means that the IP 
address is not valid or the LDK system doesn’t have IP address or there are 
some errors. 

 

 
[Fig 3-2] LAN Connect Fail 
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2. If the connection is established successfully, a message will be displayed in 
[Display Area]. The success of connection means that the connection between 
this program and the NIC of the PC is succeeded. This does not mean the 
connection between this program and LDK system is succeeded. 

 

[Fig 3-3] LAN Connect Succeed 
3. If the LAN port is already connected, the sub-menu and the tool button for 

LAN connection cannot be selected. 
 

Procedures: 
1. Select [Connection] menu. 
2. Select [LAN Connect] in [Connection] menu. 

3. Or, user can use tool button  in [ToolBar] to execute the same command. 
 

3.3.3.  [LAN Disconnect] Sub-menu 
[LAN Disconnect] disconnects the LAN connection between PC and LDK. 
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Conditions: 
1. If the LAN connection are already disconnected, the menu and the toolbar for 

LAN disconnection cannot be selected. 
Procedures:  

1. Select [Connection] menu. 
2. Select [LAN Disconnect] sub-menu in [Connection] menu. 
3. Or, user can use tool button  in [ToolBar] to execute the same command. 

 

3.4 ISDN Connection with LDK System 
For the ISDN connection between PC and LDK system, PC must have a ISDN S-

Card.  
 
Conditions: 

1. The PC should have ISDN S card(ISDN Modem) to connect the LDK system 
via ISDN Line. And ISDN modem drive should be installed on your PC. 

2. LDK system should have ISDN BRIB or PRIB or STIB T Mode. 
 

3.4.1.  [ISDN Configure] Sub-menu 
[ISDN Configure] is for configuring the telephone number that is to be connected to 
LDK system. 
 
Conditions: 

1. When the ISDN modem connection is established, user cannot select this menu. 
The menu item is disabled in that case. 

2. Setting values are stored for the next session at which they are automatically 
restored and used. But only one telephone number will be saved. 

 

 

 
[Fig 3-4] ISDN Phone Number 
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Procedures: 
1. Select [ISDN Configure] sub-menu in [Connection] menu. 
2. [ISDN Configuration Dialog] shows up. 
3. Enter the telephone number. 
4. Click [OK] button. 
 

3.4.2.  [ISDN Connect] Sub-menu 
[ISDN Connect] connects the PC and LDK system with the setting telephone number 
from [ISDN Configure]. 
 
Conditions: 

1. If the connection is failed, an error message shows up. It means that the 
destination site telephone number is not valid. In this case check the telephone 
number that you have entered. 

 

 
[Fig 3-5] ISDN Connect Fail 

2. If the connection is established successfully, a message box will be. The 
success of connection means that the connection between this program and the 
ISDN modem of the PC is succeeded. This does not mean the connection 
between this program and LDK system is succeeded. 

 

 

3. If the ISDN port is already connected, the sub-menu and the tool button for 
ISDN connection cannot be selected. 

 
Procedures: 

1. Select [Connection] menu. 
2. Select [ISDN Connect] in [Connection] menu. 
3. Or, user can use tool button  in [ToolBar] to execute the same command. 

 



IPLDK Remote Diagnostic                Issue 3.0 

 

22 

3.4.3.  [ISDN Disconnect] Sub-menu 
[ISDN Disconnect] disconnects the ISDN connection between PC and LDK. 
 
Conditions: 

1. If the LAN connection is already disconnected, the menu and the toolbar for 
LAN disconnection cannot be selected. 

Procedures:  
1. Select [Connection] menu. 
2. Select [LAN Disconnect] sub-menu in [Connection] menu. 

i. Or, user can use tool button  in [ToolBar] to execute the same 
command. 
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4.  [Commands] Menu 
This program can send commands to LDK system to get diagnostic results while a 
connection is established. This program reads command configuration from 
[CmdConf.txt] file that is installed with executable file, and use the data for [Menu], 
[Command Bar], and [Input Box Bar]. [CmdConf.txt] file is command 
configuration file, and the contents of the file follow special rules for command 
configuration. 

 

 
[Fig 4-1] Commands menu 

4.1. Executing Commands 
The following is the description about how to execute commands. 
* This program does not check the validity of command argument that is needed for 
some commands, and error handling is done in LDK system. 
 

4.1.1  Using [Commands] Menu 
 [Commands] menu includes all the commands from [CmdConf.txt] file. 
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[Fig 4-2] Command Arguments Dialog 

 Procedures 
1. Select [Commands] menu  =>  Sub-menu of [Commands] menu is shown. 
2. Click on the sub-menu of the command to be executed. 
3. If the command needs an argument, [Enter Command Argument Dialog] 

shows up. Enter a proper argument in it. The length of the argument is 
limited to 6 characters. 

4. The command is executed. 

4.1.2  Using [Command Bar] 
 Procedures for Executing [Commands] 

1. Click the button of the command to be executed in [Command Bar]. 
2. If the command needs an argument, [Enter Command Argument Dialog] 

shows up, and user can enter proper argument in it. The length of a argument 
is limited to 6 characters. 

3. The command is executed. 
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4.1.3  Using [Input Box Bar] 
[Input Box Bar] can be used to execute almost all the monitoring and diagnostic 
commands supported by LDK system. Command usages and limitations follow LDK 
system specification. The length of input in [LDK Command Edit Box] is limited to 
40 characters 
[Input Box Bar] can be docked on the top or bottom side of the window. 

 Procedures for Using [LDK Command Edit Box] and [Enter] Button 
 

 
[Fig 4-4] Edit Dialog 

 
1. Click on [LDK Command Edit Box] so that input cursor comes to be 

blinking inside the box. If input cursor already exists in [LDK Command 
Edit Box], this procedure is not needed. 

2. Input LDK command in [LDK Command Edit Box]. The length of the 
input is limited to 40 characters. 

3. Click [Enter] button to send the command input in [LDK Command 
Edit Box] to LDK system. Or, user can press [Enter Key] on keyboard to 
send the command. 

 If [Enter] button is clicked when [LDK Command Edit Box] is empty, a 
character that corresponds to [Enter Key] is sent to LDK system. The 
same operation can be done by pressing [Enter Key] when input cursor 
exists in [LDK Command Edit Box]. 

 If user wants to log-in again to LDK system after log-out from maintenance 
or monitor mode, he/she can click [Enter] button to get a chance to input 
password                                                          
and log-in again. 

 When user tries to execute a remote command (r-type command) that needs 
an argument by typing the command in [LDK Command Edit Box], 
he/she should also type the argument with the command. For [LDK 
Command Edit Box], [Enter Command Argument Dialog] is not 
provided. 
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4.2. Functions of Commands 
Commands provided by LDK system are as follows ; 

 [Monitor Commands] that is available when user logged on with ‘jennie’ as 
password. 
 
?       - Help menu 
t b xx     - Set Board Trace 
t [c|e|h|t] ([s|c|d|t|v|#]xxx) [a|r] - Set Device Trace 
t d     - Delete Trace Info 
t p     - Show Trace Setup Info 
d [addr1] [addr2]    - Mump Memory 
m addr xx     - Modify Memory 
s ###     - STA Status 
c ###     - COL Status 
v ###     - VMIB Status 
l ###     - Logical STA Status 
p [v][s]     - Print Port Assign 
gsxd dump [all]    - GSXD dump 
x      - Exit monitor 
 

 [Remote Commands] that is available when user logged on with ‘brandy’ as 
password. 
 
?     - Help Menu 
bc     - Display Board Configuration Table 
bl     - B-channel Listening 
bs ##    - View Board Status 
db [de][dr]    - Display Diagnostic Result 
hd     - Display HDLC Status 
log [view|clear]   - Log view or clear 
reboot    - Remote System Reset 
setsw [oos|nor] ##   - Set Service Switch 
ta [all][period][atd][callsum]…… - Traffic Analysis 
ts     - Display Time-slot Assigment 
up     - S/W Upgrade 
vc [s][u][a]…   - VMIB Annc/Usr Greeting Clear 
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ws ?    - WTIB Statistics 
x     - Exit Command 
 
And [db] command’s detail information is displayed in below.  
db cc      - Configuration Constraint 
db pf    - Pre-Programmed Fault                               
db ts      - Time-Slot Conflict 
db ht    - Hiway TestPre-Programmed Fault 
db dt      - DTRU Test 
db ct    - CPTU Test 
db mt      - Memory Test 
db rt    - RTC Test 
db pc      - Power Capacity 
db rc    - RGU Capacity 

      de hs    - HDLC Status 
dr [is/ic]    - ISDN Line Status 
dr [ri/rc]    - Reset Information 
dr li [d/c/v/a]    - Resource Assignment 

 

4.2.1 Monitor – Set Board Trace 
Sets trace for board in slot xx. 

For setting trace for board in slot 7: 

     mon>t  b  07 
 

4.2.2 Monitor – Delete Trace Info 
Deletes all current trace commands and revert to idle condition. 
 

4.2.3 Monitor – Set Device Trace 

Sets trace for device.  

Command options are as following: 

c : device COMMAND tracing. (MP → PP) 

e : EVENT tracing. (PP, Internal, Timer Event) 

h : HIGHWAY tracing. 
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t : CTI device command / event tracing. 

Device options are as following: 

S : Tracing related to station 

C : Tracing related to CO 

D : Tracing related to DTMF 

T : Tracing related to CPTU 

V : Tracing related to VMIB channel 

If you want to trace the Station 102 about Cmd, Evt and Hiway information, you 
should enter the command option with physical station number as following; 

    mon>t  ceh  s002 

At the Sxxx, xxx should be physical station number, i.e., port number of station. So, 
even if the station number was changed from 102 to 702, the physical station number 
is not changed; 

    mon>t  ceh  s002 
 

4.2.4 Monitor – Dump Memory 

Dumps memory between the two addresses, which are in hexa decimal. If you omit 
one of the two address range memories are dumped beginning at address specified 
until pressing Ctrl-C. 

 

4.2.5 Monitor – Modify Memory 
Modify memory beginning at the address until pressing Ctrl−C. 
 

4.2.6 Monitor – COL Status 
This command is for showing the status of a CO line connected to LDK system. 
Conditions: 

1. This command can be executed when this program is connected to LDK system. 
2. If [OK] button is clicked without entering value in [Enter Command Argument 

Dialog], a message box that indicates this shows up. (Empty field is not allowed) 
3. User can cancel the command by clicking [X] button on the top right side of 

[Enter Command Argument Dialog]. 
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4. The length of the argument is limited to 6 characters. 
5. The argument is a physical port number that starts from 1. 
6. If non-numeric value is entered, LDK system assumes it as starting port number. 
7. If invalid value (or big value) is entered, LDK system handles the error. 

Procedures:  
1. Select [CO Status] sub-menu in [Commands] menu, or click [CO Status] 

[Command Bar] button. 
2. Or, user can input “c #” (# : Port Number) in [LDK Command Edit Box] and 

then click [Enter] button, or select [CO Status] in [Remote Command Combo 
Box] and then click [Execute] button. 

 

For showing status of CO number 07 

mon> c  07 
Here is an example of CO line status: 

 
Slot0, Chan0, State0, AscD255T255 
 
 Slot = 00, Dev No = 00, Hiway = 00, Timeslot = 2341cc 
 RX_Sum Loc = ffff, TX_Sum Loc ffff 
Ucd0, Store0, Sent0 
 
22739c 00 00 00 ff 00 00 00 ff ff ff 05 ff ff ff 01 00 
2273ac 00 ff ff ff ff 00 ff 00 00 00 00 00 00 00 00 00 
2273bc 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 
2273cc 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 
2273dc 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 
2273ec 80 00 00 10 ff ff 00 00 00 00 00 00 00 00 00 00 
2273fc 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 
22740c 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 
22741c 00 00 00 00 07 00 00 00 00 00 00 00 00 00 00 00 
22742c 00 00 ff 00 00 ff 00 ff 00 ff 64 ff 00 00 00 ff 
22743c ff 00 00 00 00 ff ff 00 00 00 00 00 00 00 00 00 
22744c 00 00 00 00 00 00 ff ff ff 00 ff 00 ff ff 00 ff 
22745c 00 00 00 ff ff 00 ff ff ff ff ff 00 00 00 
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4.2.7 Monitor – STA Status 
 

This command is for showing the status of a station connected to LDK system. 
Conditions: 

1. This command can be executed when this program is connected to LDK system. 
2. If [OK] button is clicked without entering value in [Enter Command Argument 

Dialog], a message box that indicates this shows up. (Empty field is not allowed) 
3. User can cancel the command by clicking [X] button on the top right side of 

[Enter Command Argument Dialog]. 
4. The length of the argument is limited to 6 characters. 
5. The argument is a physical port number that starts from 0. 
6. If non-numeric value is entered, LDK system assumes it as starting port number. 
7. If invalid value (or big value) is entered, LDK system handles the error. 

Procedures: 
1. Select [Station Status] sub-menu in [Commands] menu, or click [Station 

Status] [Command Bar] button. 
2. Or, user can input “s #” (# : Port Number) in [LDK Command Edit Box] and 

then click [Enter] button, or select [Station Status] in [Remote Command 
Combo Box] and then click [Execute] button. 

 

For showing status of station 107 

mon> s 008 
Here is an example of STA status: 

Slot1, Chan97, State1, AscD255T255 
Ucd0, Store0, Sent0 
Xfer0, Hold0, Held255 
 
22175c 00 01 01 04 00 61 01 ff ff ff ff ff ff 00 ff ff 
22176c ff ff ff 40 00 00 80 00 60 18 00 00 00 ff ff 00 
22177c 00 00 00 00 00 ff ff ff ff 00 0a 08 00 ff 00 00 
22178c ff ff 00 00 ff 00 00 00 00 00 00 00 ff ff ff ff 
22179c ff ff ff 00 ff 00 00 00 00 00 00 00 00 00 00 00 
2217ac 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 
2217bc 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 
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2217cc 00 00 00 00 00 00 00 ff ff ff ff ff ff ff ff ff 
2217dc ff ff ff ff ff ff ff ff ff ff ff ff ff ff ff ff 
2217ec ff ff ff ff ff ff ff ff ff ff ff ff ff ff ff ff 
2217fc ff ff ff ff ff ff ff ff ff ff ff ff ff ff ff ff 
22180c ff ff ff ff ff ff ff ff ff ff ff ff ff ff ff ff 
22181c ff ff ff ff ff ff ff ff ff ff ff ff ff ff ff ff 
22182c ff ff ff ff ff ff ff ff ff ff ff 00 00 13 39 2e 
22183c 00 2a 05 00 ff 00 00 00 00 00 00 14 00 01 00 00 
22184c 00 00 00 00 00 00 00 00 00 01 00 00 00 00 00 00 
22185c 00 00 00 ff 00 18 00 00 00 00 ff ff ff ff 01 b8 
22186c 00 00 ff ff 00 00 00 00 00 22 18 74 00 22 18 74 
22187c 00 22 18 7c 00 22 18 7c 00 00 00 00 ff 00 ff ff 
22188c 00 00 00 ff 84 ff ff ff ff 02 84 ff ff ff ff 02 
22189c ff ff 00 00 00 ff ff 00 
 

 

4.2.8 Monitor – Print Channel Assign 
Sets print port. You can select one of several print ports. By default, serial interface 
unit 1 is used. 
 

4.2.9 Monitor – x 
This command is for log-out from LDK system. 
Conditions: 

1. This command can be executed when this program is connected to LDK system. 
Procedures:  

1. Select [Log Out] sub-menu in [Commands] menu, or click [Log Out] 
[Command Bar] button. 

2. Or, user can input “x” in [LDK Command Edit Box] and then click [Enter] 
button, or select [Log Out] in [Remote Command Combo Box] and then click 
[Execute] button. 

4.2.10 Monitor - ? 
This command is for showing the help messages of [Remote Commands]. 
Conditions: 

1. This command can be executed when this program is connected to LDK system. 
Procedures:  
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1. Select [Help Message] sub-menu in [Commands] menu, or click [Help 
Message] [Command Bar] button. 

2. Or, user can input “?” in [LDK Command Edit Box] and then click [Enter] 
button, or select [Help Message] in [Remote Command Combo Box] and then 
click [Execute] button. 

 

4.2.11 Maintenance - Display Board Configuration Table(bc) 
 
This command is for showing the board configuration of LDK system. 
Conditions: 

1. This command can be executed when this program is connected to LDK system. 
2. User can confirm the configuration of the boards installed in LDK system. 

Procedures: 
1. Select [Board Configuration] sub-menu in [Commands] menu, or click [Board 

Configuration] [Command Bar] button. 
2. Or, user can input “bc” in [LDK Command Edit Box] and then click [Enter] 

button, or select [Board Configuration] in [Remote Command Combo Box] 
and then click [Execute] button. 

 

4.2.12 Maintenance - B-channel Listening(bl) 
Listens B-channel of specified time slot. 

 

4.2.13 Maintenance - View Board Status(bs ##) 
This command shows board status. ## is slot number. 
 

4.2.14 Maintenance - Display HDLC Status(hd) 
This command shows HDLCstatus. 
 

4.2.15 Maintenance - Log View or Clear(log [view|clear]) 
Log information can be viewed and cleared by this command. 
 

4.2.16 Maintenance - Remote System Reset(reboot) 
This command resets the system. You should enter admin password twice to reset the 
system. If the admin password does not exist, 147* is used temporarily for admin 



IPLDK Remote Diagnostic                Issue 3.0 

 

33 

password. 
 

4.2.17 Maintenance - Traffic Analysis(ta [all][period][period_abort][atd][callsum] 
[callhour] [hw] [cosum] [cohour]) 

 
Shows traffic analysis data. 
Command options are as following: 
ta all          <timetype>           - Print All Traffic Report 
ta period       <hhmm> <timetype>  - Print Traffic Report Periodically 
ta period_abort                      - Cancel Periodic Print 
ta atd          <timetype>          - Print Attendant Traffic Report 
ta callsum                          - Print Call Summary Report 
ta callhour                          - Print Call Hourly Report 
ta hw           <timetype>          - Print H/W Usage Summary Report 
ta cosum        <timetype>        - Print CO Traffic Summary Report 
ta cohour        <cogrp#>          - Print CO Traffic Hourly Report 
 
                 timetype         - [tt|yt|lh|yp|tp] 
                                  - tt : Today Total 
                                  - yt : Yesterday Total 
                                  - lh : Last Hour 
                                  - yp : Yesterday Peak 
                                  - tp : Today Peak 
Refer to 2.30 Traffic Analysis for detailed information and print form. 
 

4.2.18 Maintenance - Display Time-slot Assignment(ts) 
Displays time-slot assignment. 

 

4.2.19 Maintenance - S/W Upgrade(up) 
Upgrades software. 
 

4.2.20 Maintenance - WTIB Statistics(ws ## [command]) 
SHOWS WTIB STATISTIC DATA. 

Command options are as following: 

[?]     : Help 
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 [upload] : Upload Data statistics data 

 [call]   : Total number of call & direction of the call 

 [subs]  : Information per subscripted device 

 [eoc]   : End of call 

[cell]   : Usage of frequency and slot 

 [traf]   : Show holding time 

 [acce]  : Access info.(basic/hand-over) 

[clea]  : Clear statistics data 

Refer to WTIB Statistics for more detailed information and print form. 

 

4.2.21 Maintenance - Exit(x) 
This command is for log-out from LDK system. 

Conditions: 
1. This command can be executed when this program is connected to LDK system. 

Procedures:  
1. Select [Log Out] sub-menu in [Commands] menu, or click [Log Out] 

[Command Bar] button. 
2. Or, user can input “x” in [LDK Command Edit Box] and then click [Enter] 

button, or select [Log Out] in [Remote Command Combo Box] and then click 
[Execute] button. 

 

4.2.22 Maintenance - Help(?) 
This command is for showing the help messages of [Remote Commands]. 
Conditions: 

1. This command can be executed when this program is connected to LDK 
system. 

Procedures:  
1. Select [Help Message] sub-menu in [Commands] menu, or click [Help 

Message] [Command Bar] button. 
2. Or, user can input “?” in [LDK Command Edit Box] and then click [Enter] 

button, or select [Help Message] in [Remote Command Combo Box] and 
then click [Execute] button. 
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4.2.23 Diagnostic – Configuration Constraint(db cc) 
Shows if the current configuration meets the configuration constraints. 

   

4.2.24 Diagnostic – Pre-programmed Fault(db pf) 
Shows pre-programmed faults. Checks if the admin programmed data are different 
from the boards that are installed in the system. Prints warning message if there is any 
difference. 
 

4.2.25 Diagnostic - Time-slot Conflict(db ts [sl][cf]) 
  Shows time-slot assignment table and time-slot assignment conflict status. In case of 
PRIB, channel 31, 32 should be assigned the same time slot with that of channel 1. 
Command options are as following: 

[sl] – time-slot assignment table 
[cf] – time-slot conflict 

 

4.2.26 Diagnostic – Hiway Test(db ht ## ## #) 
Tests PCM hiways using one DKT and one DTMF receiver. If you assign slot number, 

dtmf receiver duration time, and hiway number, this program tests 48 time-slots in the 
specified hiway. Note that the first DKT of the assigned slot is used for the test. The 
DKT is connected to time-slot successively and DTMF tone is connected to that time-
slot too. If the DKT receives the specified DTMF tone, we regard the time-slot operates 
correctly. 

 
Usage: db ht xx yy # ( xx: slot number(DTIB), yy: dtmf duration time, #: hiway 

number(0-7)) 
 

4.2.27 Diagnostic – DTRU Test(db dt) 
Tests DTMF receiver. This feature tests all DTMF receivers in the system. Currenlty 
max 32 dtmf receivers can be tested 
 

4.2.28 Diagnostic – CPTU Test(db ct) 
Tests CPTU. 
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4.2.29 Diagnostic – Memory Test(db mt) 
Tests DRAM modules. Writes specified value(e.g. 0x5a) to the DRAM and reads 
again, to check if the valid data are read. 
 

4.2.30 Diagnostic – RTC Test(db rt) 
Tests RTC. You can see current time and modify it. The time does not elapse when 
you test RTC, so you have to correct the time before you finish it. 

 

4.2.31 Diagnostic – Power Capacity(db pc) 
Shows power capacity of the PSU and current power usage status of the system. If the 
total power usage per rack exceeds the limit, you should change the confiugration. 
 

4.2.32 Diagnostic – RGU Capacity(db rc) 
Shows RGU capacity. This feature shows RGU capacity, CO incoming ring cadence 
and ICM call ring cadence. You don’t have to uninstall the station even if the number 
of stations exceeds the RGU capacity. 

 

4.2.33 Diagnostic – HDLC Status(de hs) 
Shows HDLC status. 

 

4.2.34 Diagnostic – ISDN Line Status(dr is) 
Shows ISDN line status information. 

4.2.35 Diagnostic – Reset Information(dr ri) 
Shows reset information. 

 

4.2.36 Diagnostic – Resource Assignment(dr li [d|c|v|a]) 
Shows current resource assignment 
    d – DTMF receiver assignment 
 c – CPTU assignment 
 v – VMIB channel assignment 
 a – DTMF, CPTU, VMIB channel assignment 
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5.  [View] Menu 
[View] menu is used for showing / hiding [ToolBar], [Status Bar], [Command Bar], 
[Input Box Bar], and for clearing [Data Display Area] and starting a new document. 
 

 
[Fig 5-1] View menu 

5.1. [ToolBar] Sub-menu 
[ToolBar] sub-menu is working in toggling way, and a check mark is shown when 
[ToolBar] is shown on the screen. 
Procedures: 

1. Select [ToolBar] sub-menu in [View] Menu. 
2. If [ToolBar] is shown on the screen, it becomes to be hidden, and if it is hidden 

already, it becomes to be shown. 
 

5.2. [Command Bar] Sub-menu 
[Command Bar] sub-menu is working in toggling way, and a check mark is shown 
when [Command Bar] is shown on the screen. 
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Procedures: 
1. Select [Command Bar] sub-menu in [View] Menu. 
2. If [Command Bar] is shown on the screen, it becomes to be hidden, and if it is 

hidden already, it becomes to be shown. 
** Command Bar is enabled only after you have entered Monitor or Maintenance Mode. 

5.3. [Input Box Bar] Sub-menu 
[Input Box Bar] sub-menu is working in toggling way, and a check mark is shown 
when [Input Box Bar] is shown on the screen. 
Procedures: 

1. Select [Input Box Bar] sub-menu in [View] Menu. 
2. If [Input Box Bar] is shown on the screen, it becomes to be hidden, and if it is 

hidden already, it becomes to be shown. 
 

5.4. [Clear New] Sub-Menu 
[Clear New] sub-menu is used for clearing [Data Display Area] and starting a new 
document. Because new document has no name (or title) yet, ‘Untitled’ is shown on the 
[Title Bar] of the window as a document name. 
Procedures: 

1. Select [Clear New] sub-menu in [View] Menu. 
2. Or, user can use tool button  in [ToolBar] to execute the same command. 
3. All the data displayed in [Data Display Area] are erased, and new document is 

started. 
 



IPLDK Remote Diagnostic                Issue 3.0 

 

39 

6.  [Help] Menu 
In [Help] menu, only [About LDK Remote Diagnostic Tool] sub-menu exists. 
 

 
[Fig 6-1] Help menu 

6.1. [About LDK Remote Diagnostic Tool] Sub-menu 
When [About LDK Remote Diagnostic Tool] sub-menu is clicked, [About LDK 
Remote Diagnostic Tool Dialog] shows up, and the name of this program and 
copyright information is displayed on the dialog. 
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[Fig 6-2] About Dialog 
Procedures: 

1. Select [About LDK Remote Diagnostic Tool] sub-menu in [Help] menu. 
2. Or, user can use tool button  in [ToolBar] to execute the same command. 
3. [About LDK Remote Diagnostic Tool Dialog] shows up. 
4. When [OK] button is clicked, [About LDK Remote Diagnostic Tool Dialog] 

disappears. 
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7.  [Data Display Area]  
[Data Display Area] displays the data from serial port, modem or data file. When 
displaying data, this area follows some rules and executes functions according to them. 

7.1. Data Display Functions 
If the data to be displayed exceeds the size of [Data Display Area], a vertical scroll bar 
appears to enable scrolling [Data Display Area]. Horizontal scroll bar is always 
displayed even though the width of displayed data does not exceed the size of [Data 
Display Area]. 

 While data are coming from serial port or modem, [Data Display Area] is 
automatically scrolled to the last line if the data to be displayed exceeds the size of 
[Data Display Area]. 

 If the data are from data file, [Data Display Area] is not scrolled to the last line 
but displays the data from the first line. 

 If a data file is opened while data are coming from serial port or modem and being 
displayed in [Data Display Area], previously displayed data are erased and new 
data from data file are displayed in [Data Display Area]. If more data are still 
coming from serial port or modem, the data are appended after the last line of the 
file data and the file name remains the same. This is for preventing loss of real 
time data from serial port or modem. 

 If user executes a LDK command after opening a data file, the file is closed and 
new file (or document) is started with the name “Untitled”. 

 Once a file name is assigned for the data in [Data Display Area] by using [Save] 
sub-menu or [Save As] sub-menu, the file name remains the same even though 
more data are coming from serial port or modem and being displayed. Therefore, 
the appended data can be stored in the same file. 

 If [Clear New] sub-menu is selected or [Clear New] tool button is clicked, [Data 
Display Area] is cleared and a new document (or file) named “Untitled” is started. 

 

7.2 Automatic Data Storing Functions 
[Data Display Area] does not scroll indefinitely. If the number of lines of displayed 
data exceeds 2,000 lines (in general), this program stores the displayed data into a data 
file and clears [Data Display Area]. Then, this program keeps displaying incoming data 
in [Data Display Area]. The maximum number of lines of data is system dependant. If 
the PC is using smaller fonts, more lines will be displayed. 
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 In general, if more than 2,000 lines of data are displayed in [Data Display Area], 
the data are stored in a data file automatically. The name of the file has the format 
of “Thhmmss.dat” (hh : current hour ,  mm : current minute ,  ss : current 
second), and this file is saved in the directory this program is installed. User can 
open this file by using [Open] sub-menu or [Open] tool button to see the contents 
of the file. 

 While automatic data storing function is being executed, several bytes of data may 
be lost. This happens especially when the data transfer rate is high and 
performance of PC is low or the PC is busy working other jobs. And, the first line 
of data displayed after automatic data storing function is executed may have 
broken format. 

 

7.3 Important Notes for Users 
If the performance of the PC is not good enough, some scrolled data may not have 
complete forms. If this happens, scroll [Data Display Area] by using scroll bar to 
refresh the area.  


